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2 User Interface

 

The presented program is a stand-alone application designed for the Macintosh

 



 

 platform. The

program and the corresponding files are graphically represented by distinctive icons (Fig. 2–1)

appearing in the windows of the operating system. 

 

Fig 2–1: 

 

Graphic representations of the program and the corresponding file.

 

Moreover, the program supports an user interface which enables via windows, menus and

graphic elements an organized and simple formulation of an arbitrary kinematic system, an

easy control of the computation and a clear representation of the computed data. It has been

designed according to the 

 

User interface guidelines

 

 of a Macintosh

 



 

 platform to a great ex-

tent. 

It basically consists of the following elements:

- Project windows with various tools.

- Menus. 

- Graphic elements used for the definition of the topology of kinematic systems. 

- Diagram elements for graphic representation of computed data.

- Various input windows for the definition of the constant parameters and functions.

 

2.1 Project Window

 

Each examined kinematic system is associated with its 

 

Project window 

 

which represents the

main component of the user interface (see Fig. 2–2). Moreover, it is possible to open more

than just one 

 

Project window 

 

at the same time. However, various commands, tools and com-

putation procedures can be used for the currently active window and the corresponding kine-

matic system only. The most important parts of a 

 

Project window 

 

are the title bar where the

name of the project is shown, the tools palette and the worksheet.
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2.1.1 Worksheet

 

On the worksheet graphic elements which represent various elements of kinematic systems,

diagrams and text elements can be generated and displayed (see Fig. 2–2). These graphic ele-

ments can be, like in the common graphic editors, selected and dragged to any position on the

worksheet. Moreover, the selected elements can be copied, pasted and duplicated by using the

“duplicate” command or deleted by pressing the 

 

Delete

 

 key. The size of the worksheet can be

specified by the user and any of its regions can be accessed by using the scroll-bars if it is

larger than the 

 

Topology window

 

. 

 

2.1.2 Tools Palette

 

A tool is activated by clicking the field with its symbol in the tools palette (see Fig. 2–2). After

a tool has been selected, the shape of the cursor in the worksheet is changed appropriately in-

dicating the currently active tool.

 

Fig 2–2: 

 

Project window 

 

with graphic elements representing the topology of the linkage, text elements
and diagrams.

Tools Palette

Worksheet Diagrams

Text Elements

Graphic Elements Connection Cord Title Bar
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The tools palette is divided into two main sections. Its first section contains tools for manipu-

lation on various graphic objects and data displayed in the worksheet (See Fig. 2–3). It con-

tains following tools:

 

- 

 

Selector Tool

 

It is used to select and drag graphic objects on the worksheet and to activate input dialog

boxes of structural or control elements.

 

- 

 

Point Picker Tool

 

It is used to display the accurate coordinates values of any point on a curve in a diagram ele-

ment. By clicking a curve in a diagram element, the closest point is selected and its coordi-

nates are displayed on the bottom of the diragram element. In the case that the computed data

of a kinematic system is shown in more than one diagram element, the point which corre-

sponds to the same solution set of variables as the clicked point is selected in each diagram

(See subsection 2.5.1).

 

- 

 

Connecting Tool

 

- With this tool a body or a control element can be connected to any of the created joints or

constraint elements. The 

 

Connecting Tool

 

 doesn’t connect two elements of the same type, and

it allows to make only two connections to each joint or constraint element. Furthermore, it

doesn’t allow any connections between the control elements and bodies. After selecting the

 

Connecting Tool

 

, the actual connection is established in three steps as follows:

1.) Click with the 

 

Connecting Tool 

 

the symbol of one of the elements on the worksheet.

2.) Pull the connection cord from the initially selected element without releasing the mouse

button till the second element is targeted.

3.) If the targeted element can be connected to the initially chosen element, it is highlighted

and the connection is established as soon as the mouse button is released.

 

- 

 

Nippers Tool

 

It is used to disconnect the connection cords which were created with the 

 

Connecting Tool

 

. Af-

ter selecting the 

 

Nippers Tool

 

, the nippers cursor opens as soon as it is close enough to any

cord which can be cut by clicking the mouse button. 
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Fig 2–3: 

 

Fields of the tools palette where the manipulation tools are activated.

 

The second section of the tools palette contains the tools for the creation of elements of kine-

matic networks, diagram elements and text elements (See Fig. 2–4). 

 

Fig 2–4: 

 

Fields of the tools palette where the creation tools are activated.

 

After selecting a creation tool, a new element is generated by clicking into the worksheet of

the 

 

Topology window

 

.

The creation tools are:

 

- 

 

Joint Tools

 

These tools are used for the creation of all types of joints described in the section. For each

joint type a specific tool is provided and activated by selecting the appropriate tool field of the

tools palette which is marked with the symbol of the joint.

 

- 

 

Constraint Element Tools

 

These tools are used for the creation of constraint elements discussed in the section.

Selecting Tool

Connecting Tool

Point Picker

Nippers

R-Joint Tool

H-Joint Tool

G-Joint Tool

GG -Constraint Tool

CRC-Constraint Tool

Body Tool

Diagram Tool

P-Joint Tool

C-Joint Tool

U- Joint Tool

EG -Constraint Tool

GC -Constraint Tool

Control Element Tool

Text Element Tool



 

Chapter 2: User Interface

 

10

 

- 

 

Body

 

, 

 

Control Element

 

 and 

 

Diagram tools

 

They are used for the creation of body, control elements and diagram elements, respectively.

 

- 

 

Text Tool

 

It is used to insert text elements anywhere on the worksheet. By selecting the 

 

Text Tool

 

 and

clicking the spot in the worksheet, thus defining the position of the desired text, the dialog box

is shown in which the text can be written and various fonts, styles and sizes can be chosen.

 

2.2 Graphical Representation of Structural and Control Elem

 

Each element of a kinematic system is represented by an icon which corresponds to its type

(See Fig. 2–5). At the bottom of each icon a label with the default element name is attached

while on the top the current element number is added. Both, the name label and the current

number can be changed by the user in the same way as the file names on the desktop of the

Finder

 



 

 on the Macintosh

 



 

 computers.

 

Fig 2–5: 

 

The symbols of provided joints, constraint elements, control element and body.

 

The symbols contain a question mark as long as their element parameters are not defined or

necessary connections are missing.

Since a graphic representation of a kinematic system can be sometimes very complex, each el-

ement of a kinematic network can be represented by more than just one graphic element, the

so called 

 

Aliases

 

. Each of these 

 

Aliases 

 

can be positioned anywhere on the worksheet and con-

nected to other elements (see Fig. 2–6). Their distinctive style of the name label and the object

number indicates that a graphic element belongs to a group of graphic elements representing

one structural or control element.
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Fig 2–6: 

 

The equivalent topology representations a.) and b.) of a Stewart platform. In the case b.), the
control element is represented by two graphic elements (

 

Aliases

 

).

 

2.3 Defining Parameters of Structural and Control Elements

 

The parameters of a structural or control element are determined in a special input box which

is opened either by double clicking the symbol of an element on the worksheet or by choosing

command 

 

Object Info

 

 from the 

 

Object Menu

 

. An input box is divided into sections and its con-

figuration depends on the type of a structural or a control element. In the title bar of each input

dialog box, the name of the current element is shown while its type, corresponding object

number and graphic symbol are displayed below the title bar. 

 

2.3.1 Input Boxes of Revolute, Prismatic, Helical, Cylindrical and Global Joints

 

These types of dialog boxes are very similar to each other and they are divided into the follow-

ing sections:

 

- The 

 

Parameters

 

 section 

 

It allows either a definition of the general constant geometric parameters (

 

Full parameters

 

), or

the 

 

Denavit-Hartenberg (DH)parameters

 

 as described in the subsections  3.2.2 and  3.2.5, re-

spectively. The type of the geometric parameters is chosen by the pop-up menu which is posi-

tioned next to the title of the 

 

Parameters

 

 section. 

In the case of 

 

Full parameters

 

, (See Fig. 2–7), two separated subsections 

 

Body 1

 

 and 

 

Body 2

 

are shown in the 

 

Parameters

 

 section. In each subsection a set of vectors ,  and  de-

scribing the position of the joint and the orientation of its axis are determined relative to one of

the connected bodies (See subsection 3.2.2.).

a.) b.)

ai mi ni
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At the beginning of the 

 

Body 1

 

 subsection, a pop-up menu is displayed which is used to

choose one of the connected bodies as the reference body of the vector coordinates defined in

this subsection. The name of the remaining body is shown in the title of the 

 

Body 2

 

 subsection

and automatically defined as the reference body of this subsection. To each body name appear-

ing in the both subsection titles and pop-up menus, the corresponding object number is at-

tached. 

In order to simplify the definition of the vectors  and , it is sufficient to determine vec-

tors  and  which are not parallel and only the direction and orientation of the vector 

has to be defined correctly. Internally, the coordinates of the vector  and the component of

the vector  which is normal to the vector  are normalized.

 

Fig 2–7: 

 

Input box -

 

Full parameters

 

 mode

 

In the case of 

 

DH parameters

 

, however, three editable input fields for the 

 

Denavit-Hartenberg

parameters 

 

(See subsection 3.2.2)are shown and the pop-up menu in which the reference body

has to be chosen is enabled (Fig. 2–8).

 

Fig 2–8: 

 

Input box-

 

Denavit Hartenberg parameters

 

 mode.

mi ni

mi ni ni

ni

mi ni
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The 

 

DH parameters

 

 of a global joint are determined with the same parameters as the revolute

joint and the additional two axes of rotation are automatically determined in such a way that

all axes are perpendicular to each other.

 

- The 

 

Variables

 

 section

 

In this section, the values of any variable parameter of the current joint can be defined either

by a constant or a function which uses one or more variable parameters, supplied by control

elements. In this section, an editable text field is assigned to each variable parameter and acti-

vated by clicking the check box, which is positioned to the right of the field (Fig. 2–9). If this

text field is activated, the value of the variable can be appropriately determined.

 

Fig 2–9: 

 

A 

 

Variables

 

 section of the input box of the global joint. The expressions for 

 

Theta1

 

 and 

 

Theta3

 

,
contain also variables 

 

p1

 

 and 

 

p2

 

 which are supplied by the control elements.

 

In general, parameters can be defined by various mathematical expressions, which can be

typed directly into the corresponding editable text fields. These mathematical expressions are

checked and evaluated one after another by the parser when the box is closed with the 

 

OK

 

 but-

ton. In the case that either the syntax of any expression is not understood by the parser or a

runtime error has been detected, the box is not closed and the cursor is positioned to the edit-

able field where the problems have been first encountered. 

All changes made to the parameters are ignored if the dialog box is closed by clicking the

 

Cancel

 

 button. 

Additionally, the expressions of parameters can be defined by using the 

 

Math editor

 

 where all

available functions and constants are listed and arbitrary expressions can be defined and ana-

lyzed. Moreover, also new functions and constants which are specific only to the current joint

and used for the definitions of its parameters can be defined in the 

 

Math editor

 

. In order to

open the input box of the 

 

Math editor

 

, one of the editable text fields has to be first activated

and the button 

 

Edit Expression...

 

 has to be clicked.

 

2.3.2 Input Box of User Defined Joints

 

In this input dialog box, an arbitrary relative transformation of the two connected bodies can

be defined.
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At the top of this input box a pop-up menu is displayed where one of the connected bodies is

chosen as the reference body. The input dialog box is further divided into:

- The Orientation section 

In this section the relative orientation of the two connected bodies is defined by the two vec-

tors  and  (Full-parameters, See Fig. 2–10) which define the coordinate system of the ro-

tated body relative to the reference body (See subsection  3.2.2).

Fig 2–10: Input box of a user defined joint (Full parameters mode).

- The Translation section

It is used to determine the coordinates of the vector  describing the relative translation be-

tween the origins of the body coordinate systems of the two connected bodies.

The vector coordinates can be determined by constant values or any function which is ac-

cepted by the Parser. In order to define a movable joint at least one vector coordinate has to be

determined by an expression which uses one or more variable parameters. These variable pa-

rameters are supplied by control elements which are connected to the user defined joint.The

buttons of this input box function in the same way as those in the previously discussed input

box.

2.3.3 Input Box of Bodies

The input box of a body is used for the definition of point and direction vectors in a body coor-

dinate system. The point and direction vectors are needed to compute the body position and

mi ni

ai
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orientation relative to the coordinate system of an arbitrary reference body of the kinematic

system. This box contains the following elements:

Fig 2–11: Input box of a body.

- The Point&Direction Vectors scroll-list

In this scroll-list all direction and point vectors of the currently edited body are listed. By se-

lecting a vector in the scroll-list, its coordinates are immediately displayed in the three editable

text fields which are positioned next to the scroll-list. Additionally, appropriate radio button

positioned below the three editable text fields is activated indicating the type of the currently

selected vector. The coordinates of the selected vector can be determined by using various

constants and functions which are defined and analyzed by the parser. 

- The Change button

- By clicking this button, positioned underneath the scroll-list, the changes made to the vector

coordinates are accepted only if the parser doesn’t detect any syntax or run-time errors while

checking the expressions in the editable text fields. Otherwise, the cursor is positioned to the

editable text field where the first error has been encountered.

- The Add button

By clicking this button, a new vector is created and added to the Point&Direction Vectors

scroll-list. Before adding a vector to the Point&Direction Vectors scroll-list, its coordinates

have to be defined and the type of the vector has to be determined by clicking either the Point

Vector or Direction Vector radio button. A unique name among all vectors of the current body

is automatically assigned to the new vector. The names of point vectors are composed of the

letter P and its current number while the names of direction vectors begin with the letter D in-

stead. Also in this case the expressions of the vector coordinates are controlled by the parser

before the vector is added to the list. 
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- The Remove button

By clicking this button, the selected vector is removed from the Point&Direction Vectors

scroll-list.

- The Export... button

By clicking this button, the Export Data dialog box of the body is opened (see Fig. 2–12).In

the scroll-text field an arbitrary text can be written. This text is used for generating export text

files (See “Exporting Data” on page 34.). It is automatically attached to the export text file

when the file is generated. With the help of separators and vector notation we are able to spec-

ify strings which are replaced by the actual computed data. 

Fig 2–12: Export Data dialog box.

2.3.4 Input Box of Control Elements

This input box (Fig. 2–13) is used to define the properties and the name of the parameter

which is supplied by this control element. In the main section, the following data can be de-

fined:

- The Variable Name text field

In this editable text field the name of the parameter is shown and can be changed. However, it

has to be unique among all constant and variable parameter names used for the definition of

the entire kinematic system. To each variable parameter a default name is assigned when the

corresponding control element is created.
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- The Test Value text field

In this editable text field the test value of the parameter is set in order to test all functions

which use the current parameter. In the case that the test value causes a run-time error in any

function using this parameter, the corresponding elements of the kinematic system are set to

undefined which is indicated by a question mark in their symbols.

- The Max. Increment text field 

This text field is used to determine the maximal increment of the variable parameter. The max-

imal increment is used in the numerical iteration in order to find a controlled variable and

check if the computed solution vector is unique.

- The Range subsection

In this subsection the range of the current parameter is determined in the Max. and Min. text

fields. Moreover, by checking the Periodic checkbox the current parameter can be defined as a

periodic variable parameter.

Fig 2–13: Input box of a control element.

Beside the usual syntax analysis of the mathematical expressions also the name of the parame-

ter, the test value, maximal increment and the range are checked when the OK button is

clicked. In the cases that the name of the parameter is not unique, the test value is out of range,

the increment is greater than the range or the range limits are not correct, the box is not closed

and the cursor is positioned to the editable field where the first error has been encountered.

2.3.5 Input Dialog Box of Global-Global Constraint Elements

This input dialog box is used to determine a point in each of the two connected bodies and the

distance between these two points (See 3.2.3.).
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Fig 2–14: Input box of a global-global constraint element.

The input dialog box of Global-Global constraint elements consists of the following elements:

- The Body 1 and Body 2 sections

In the Body 1 section the coordinates of the point  (vector ) are determined in the co-

ordinate system of the body whose name is displayed in the title of this section. 

The coordinates of the second point in the other body are determined in the same way in the

Body 2 section.

- The Distance text field

This edit text field is used to determine the distance between the two points which were de-

fined in the sections Body 1 and Body 2. 

The point coordinates can be defined by expressions which contain only constants while the

distance can be also determined by using variable parameters which are provided by one or

more control elements.

2.3.6 Input Dialog Box of Eben-Global Constraint Elements

The Input dialog box of Eben-Global constraint elements,(Fig. 2–15), is used to determine a

point in one and a plane in another of the two connected bodies (See subsection  3.2.3). 

It consists of the following elements:

- The Body 1 section 

In this section the body in which the plane is fixed has to be chosen in the pop-up menu posi-

tioned next to the section title. The coordinates of the direction vector  define the orienta-

tion of the plane relative to the body coordinate system. Furthermore, the normal distance

Ci−1 ai−1

ni−1
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between the plane and the origin of the corresponding body coordinate system is determined

in the editable text field Distance.

- The Body 2 section

This section is used to determine the coordinates of the point whose motion is restricted to the

plane defined in the Body 1 section. This point is fixed to the body whose name is displayed in

the title of this section. Its coordinates (vector ) are determined relative to the coordinate

system of the body in which the point is fixed. 

- The Offset text field

This text field is used to determine the offset of the plane defined in the section Body 1 in

which the point of the other body is positioned. The plane is moved parallel to its direction

vector by adding the offset to the normal distance determined in the Offset editable text field.

The offset can be defined by a mathematical expression containing one or more variable pa-

rameters supplied by control elements.

Fig 2–15: Input box of an eben-global constraint element.

2.3.7 Input Dialog Box of C-R-C Global Constraint Elements

This input box is used for the definition of the relative position and orientation of two skew

lines which represent the axes of the relative rotation and translation of each connected body

(See subsection 3.2.3.)

ai
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Fig 2–16: Input box of an C-R-C constraint element.

- The Body 1 and Body 2 sections

In each of the Body 1 or Body 2 section the coordinates of the reference point  on the axis

(vector ) are determined in the first three editable text fields while the direction of the corre-

sponding axis (vector )is determined in the last three editable text fields. Note that all coor-

dinates determined in either section are defined relative to the coordinate system of the body

whose name is displayed in the title of the actual section. 

- The Distance text field

This edit text field is used to determine the normal distance between the two skew lines which

were defined in the sections Body 1 and Body 2. 

The point coordinates can be defined by expressions which contain only constants while the

distance can be also determined by using variable parameters which are provided by one or

more control elements.

2.3.8 Input Dialog Box of Global-Cylindrical Constraint Elements

This input dialog box is used for the determination of a cylindrical surface fixed to one body

and a point  which is fixed to the other body. The motion of this point is restricted to the cy-

lindrical surface (See subsection  3.2.3).

Ci

ai

ni

Ci
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Fig 2–17: Input box of an global-cylindrical constraint element.

- The Body 1 section

The body in which the line is fixed has to be chosen in the pop-up menu positioned next to the

section title.In the section Body 1 the coordinates of the reference point  on the axis (vec-

tor ) are determined in the first three editable text fields while the direction of the corre-

sponding axis (vector )is determined in the last three editable text fields. Note that all

coordinates in this section are determined relative to the coordinate system of the body whose

name is displayed in the pop-up menu next to the section title.

- The Body 2 section

In the three editable text fields of the Body 2 section the coordinates of the point  (vector

) whose motion is restricted to the cylindrical surface, defined in the previous section, are

defined relative to the coordinate system of the body whose name is displayed in the section ti-

tle.

- The Distance text field

This edit text field is used to determine the shortest distance between the point and the line. 

The point coordinates can be defined by expressions which contain only constants while the

distance can be also determined by using variable parameters which are provided by one or

more control elements.

2.4 Math Editor

In order to simplify the definition of constants and complicated mathematical expressions, a

special math editor is provided.

Ci−1

ai−1

ni−1

Ci

ai
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The Math editor is a dialog box where the desired mathematical expression can be created,

tested and the eventual syntax or run-time errors located. Furthermore, it allows creation of

user defined constants and functions which can be used for further definition of more complex

mathematical expressions.

Fig 2–18: Math editor.

The math editor supports the following features:

- The Mode pop-up menu

In this pop-up menu various input modes can be chosen (Fig. 2–18). The Expression mode is

used to define an expression for a parameter of a structural or control element. Moreover, the

Function and Parameter modes are used to define new functions and parameters, respectively,

which are needed for the further definitions of expressions in the Expression mode. 

If the Expression mode is selected another pop-up menu is activated where the names of all

currently editable parameters are listed. At the same time the definition of the parameter which

is currently selected in this pop-up menu is edited in the Expression scroll-text. 

Furthermore, in the case of the Function or Parameter mode an editable text field is activated

where the name of the new parameter or function with its arguments can be defined.

- The Parameters scroll-list

In this scroll-list names and values of all currently available constant and variable parameters

are displayed (Fig. 2–18). There are three types of parameters: 

1.) Constant parameters which are always available, cannot be altered or removed from the list

and their names in the scroll-list are written in the plain style. 

Mode Pop-Up Menu

Parameters Pop-Up

Expression Scroll-Text

Evaluation Display
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2.) All constant and variable parameters (defined by control elements) which have been de-

fined by the user, but they cannot be altered or removed from the list at the moment. This type

of parameters is marked by the italic style. 

3.) Constant parameters which can be added or removed from the Parameters scroll-list, their

values can be altered and their names in the list are written with the bold face letters. 

- The Functions scroll-list

In this scroll-list names and arguments of all currently available functions are displayed. Like

in the case of the Parameters scroll-list, three types of functions can be shown in the Func-

tions scroll-list.

- The Definition button 

This button is used to insert the definition of a function or value of a parameter into the cur-

rently edited expression.

- The Show button

This button activates the Show dialog box in which the definition of a function or value of a

parameter is displayed. The function or parameter has to be selected in the corresponding

scroll-list.

Fig 2–19: Show dialog box.

- The Remove button

This button is used to remove parameters and functions from the Parameters and Functions

scroll-list. However, only functions and parameters which are written in bold face can be re-

moved.
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- The Keyboard

Beside the digits, the keyboard contains also the basic mathematical operations and the

(...sep...) button which is used to set separators in the argument lists of functions with more

than one argument.

- The Logical scroll-list

In this scroll-list all standard symbols used in the boolean algebra are listed.

- The Expression scroll-text field

In this scroll-text field a mathematical expression of an arbitrary length can be created (Fig. 2–

18). A mathematical expressions can use any of the functions, parameters or symbols which

appear in the three scroll-lists. In order to insert a parameter or function name with its argu-

ments into an expression, the insertion point has to be determined and the name of the parame-

ter or function can be either typed directly or inserted by double clicking it in the scroll-list.

Moreover, the whole definition of the function can be inserted at the insertion point by select-

ing the function name in the scroll-list and clicking the Definition button. When a function

name along with its arguments is inserted, the first argument is automatically highlighted. 

- The Evaluation display

In this display the values of the created expressions or error messages are shown (Fig. 2–18).

- The Evaluate button

This button is used to test the value of an expression displayed in the expression scroll-text. If

the expression caused a run-time error or its syntax is not correct, an error message is shown in

the evaluation display.

- The Define button

This button is used to confirm the new definition of a parameter expression and to add a new

function or parameter to the corresponding list. The new expression is analyzed before the

changes are accepted and an error message is shown in the evaluation display in the case of an

error. 

The names of new parameters and functions have to be unique, compatible with the syntax

which is understood by the parser and the function arguments have to correspond to the defini-
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tion of the function. If this is not the case, an alert box is shown where the encountered prob-

lem is explained. 

- The Done and Cancel buttons

The Done button is used to close the Math editor and store all changes made to the parameters

while the Cancel button is used to close the box without accepting the new changes. 

- The syntax of mathematical expressions

The mathematical expressions defined in the math editor must comply with the syntax which

is understood by the parser (the algorithm which evaluates these expressions). The mathemati-

cal expressions can contain the following symbols:

- characters: A,B,C,D,E,F,G,H,I,J,K,L,M,N,O,P,Q,R,S,T,U,V,W,Z,X,Y,a,b,c,d,e,f,g,h,i,j,k,l,

m,n,o,p,q,r,s,t,uv,w,z,x,y,1,2,3,4,5,6,7,8,9,0;

- comma: “.”;

- mathematical operation symbols: +,-,/,*,^,=,≠,<,>,≤,≥,&,|,~;

- the parentheses: ();

The names of parameters or functions must begin with a letter and have to be unique among

all parameter or function names appearing in the math editor scroll-lists.

Each function has specific name which is defined in the editable text field next to the modes

pop-up menu (Fig. 2–20). Each function name is accompanied with a list of its variables

which are separated by the separator “;”. Moreover, between the function name and the argu-

ment list should be no space. 

Fig 2–20: Defining a function.

Expression

Function Name and the Argument List 
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2.5 Diagram

Diagrams can be created on the worksheet of the Project window simultaneously by using the

Diagram Tool in the same manner as in the case of the structural or control elements. More-

over, they are graphic objects which can be selected, dragged, modified and deleted. Each dia-

gram element consists of the following parts (See Fig. 2–21):

- The diagram title.

- The area where the curves are plotted.

- The labels of the vertical and horizontal axes which indicate the selected variable parameters.

- The vertical and horizontal scales.

- The display where the coordinates of the selected point are shown.

Fig 2–21: Diagram element.

2.5.1 Function of the Point Picker tool and Markers

Markers are set with the Point Picker tool. Whenever the Point Picker tool is moved close

enough to a point belonging to any curve in a diagram element, the coordinates of that point

are instantly displayed at the bottom of the diagram. Moreover, if there is more than one dia-

gram element on the worksheet, in all diagrams the corresponding local coordinates are simul-

taneously displayed. If the Point Picker tool is close enough to a point (coordinates displayed)

a new marker is set simply by clicking that spot. A marker is displayed as a tiny rectangle with

specific number on the side in each diagram. Each marker can be selected by clicking it with

the Selector tool and deleted by pressing the Delete key. Whenever a marker is selected the

current coordinates of the marker are displayed in all existing diagrams simultaneously.

2.5.2 Configuring a Diagram

The variable parameters, title and scales are defined in a special Diagram Info dialog box

(see Fig. 2–22). It is opened either by double clicking the diagram element or by choosing the

Object Info... command from the Object menu. 
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Fig 2–22: Diagram info dialog box.

The Diagram Info dialog box contains the following elements:

- The Title text field

The diagram title is determined in this text field.

- The Show Grid checkbox. 

If this checkbox is checked, the grid in the diagram is shown.

- The Axes section 

This section is divided into the subsections Vertical Axis and Horizontal Axis. In each subsec-

tion a variable parameter is chosen with the help of the three pop-up menus as follows:

1.)In the first pop-up menu the type of an element or a special variable is chosen. In this pop-

up menu all types of elements which are used in the current kinematic system and special vari-

ables are listed. 

2.)After choosing a type of an element, the object number of a particular element is selected in

the second pop-up menu where all available object numbers belonging to the elements of the

same type are collected. 

3.) Finally, in the third pop-up menu the variable parameter of the chosen structural element is

selected. If the chosen variable parameter needs a reference coordinate system, as for example

a coordinate of a point vector defined in a body, the pop-up menu Ref. Body, where the desired

reference body can be selected, is automatically activated.

- The Label text field 
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This text field is used to determine the label which represents the chosen variable.

- The Min. Division and Max. Division editable fields 

In these two text fields the minimum and maximum number of the grid divisions are deter-

mined.

- The Min. Value and Max. Value editable fields 

In the editable fields Min. Value and Max. Value, however, the range of the scale is defined.

The limits of the number of divisions and the value range are used in the special algorithm

which optimizes the scale of a coordinate axis.

- The Automatic Range checkbox

-If this check box is checked, a special algorithm determines a new scale of an axis automati-

cally by using the extreme values of the chosen parameter. As soon as a new extreme value of

the current parameter is found, the diagram is automatically updated with the new scale.

- The Diagram Dimensions section 

This section is used to determine the dimensions of the plotting area of a particular diagram. In

the Units pop-up menu, the unit can be defined as centimeter, inch or pixel while the width and

the height of the plotting area are determined in the Width and Height editable fields.

Moreover, the scale unit is automatically defined in degrees if the variable parameter repre-

sents an angle of rotation. By clicking the OK button, the data in the editable text fields is

checked and the Diagram Info dialog box is closed if no errors occurred. In the case that the

limits of the number of divisions or value range is not defined correctly, the cursor is automati-

cally positioned to the editable text field where the error was detected.

2.6 The Menus

The menus in the presented application supply commands for file handling, manipulation on

graphic objects and parameters of kinematic systems as well as commands for the control of

computation.
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2.6.1 The File Menu

Fig 2–23: File Menu

The File menu contains standard commands which are used for the file handling, setting of

preferences, page set-up, printing and quitting the application. The command Preferences

opens the Preferences dialog box which contains a special scroll-list where the following pref-

erence cases can be activated:

- Icons preferences are used to set the font, the text style and the size of the name and the num-

ber labels attached to the symbol of a structural or control element. Additionally, after check-

ing the Snap Icons check-box, the elements snap to an invisible grid on the worksheet. By

checking the Retain Tool check-box, the tool is not automatically changed back to the Selector

tool.

Fig 2–24: Cases of the Preferences window.

a.) b.) c.)

d.) e.) e.)
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- In the Text preferences case, the default font as well as the style, size and justification of a

text element can be determined. Similar to the Icons preferences case, there are also the Snap

Comments and Retain Tool checkbox.

- The Nippers and the Connector cases are basically the same. They contain the Retain Tool

and Make Sound checkboxes.

- The Diagram case is divided into the Label Text, the Scaling Text and the Title Text sections.

In each of these sections, the font as well as the style and size of the corresponding text type

are determined. It contains also the Retain Tool and Snap Diagram checkboxes.

- The Point Picker case is very similar to the Nippers and the Connector cases. A curve seg-

ment is emphasized in all diagrams by selecting a point on it, if the Highlite Corresponding

Curve Segment check-box is checked.

The new settings are immediately applied to all existing elements on the current worksheet as

soon as the Preferences dialog box is closed by clicking the OK button.

If the Preferences dialog box is closed by clicking the Cancel button, all changes made in the

preference cases are ignored.

2.6.2 The Edit Menu

Beside the standard commands, this menu contains the special command Alias which is used

to generate aliases representing one or more structural or control elements as follows:

1.) Select one or more graphic elements.

2.) Choose the command Alias in the Edit menu or type the Command and M keys simulta-

neously.

Fig 2–25: Edit Menu

2.6.3 The Object Menu

The Object menu is used for manipulation on graphic elements of structural elements, control

elements, diagrams and text elements. 

Fig 2–26: Object Menu
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The Object menu contains the following commands:

- Object Info...

This command opens info dialog boxes of all selected graphical elements.

- Define Selected

By choosing this command, the parameters of all selected structural or control elements are

checked. In the case that there are selected elements whose data is correct and complete but it

hasn’t been confirmed yet (question mark in the graphic symbol), the command Define Se-

lected confirms it and the element is considered as defined.

2.6.4 The Chain Menu

Fig 2–27: Chain Info.

This menu contains commands which are used for inspection and manipulation of the global

data of a kinematic chain. 

It supports the following commands:

- Chain Info...

This command is available as soon as a Project window is active and it opens the Chain Info

dialog box. 

Fig 2–28: Chain Info Box.
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In the scroll-lists Joints, Constraints, Controls and Bodies, the names of all structural and con-

trol elements are listed. Furthermore, reference bodies of all clusters are listed in the Reference

Bodies scroll-list while all closure joints are listed in the Closure Joints scroll-list. The global

reference body of the current kinematic system is displayed at the bottom of the info box. By

selecting a name of an element in any scroll-list and clicking the Info... button, the info box of

the element is opened.

- Edit Globals...

This command is, like the Chain Info, available as soon as a Project window is active and it

opens the Math editor which is used to define global constant parameters and functions. The

global parameters and functions can be shared by all structural and control elements of a kine-

matic system. Furthermore, the names of global parameters and functions have to be unique

among all existing parameters and functions defined in the current kinematic system. There-

fore, a special algorithm checks each new name and returns a message if the name is not cor-

rect or unique. In the case that the definition of a global function or constant is altered,

definitions of all elements of the kinematic system are checked on eventual run time errors. If

an error is encountered in a mathematical expression, the corresponding structural or control

element is considered as undefined and a question mark is displayed in its symbol.

- Show Tree

After choosing this command the currently used tree structure is shown by selecting the

graphic objects of all structural elements except the base body and the closure joints. This

command is enabled only after the topology analysis has been done.

2.6.5 The Computation Menu

This menu is used to start and control the computation process (see Fig. 2–29). It contains the

following commands:

- Run

By choosing this command the computation procedure is started. The computation procedure

consists of the following consecutive steps: 

a.) The kinematic chain is checked in order to find out whether its elements have been defined

and connected properly. If there is a problem the computation procedure is aborted and a dia-

log box with a warning is displayed.
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b.) The topology of the examined kinematic chain is analyzed in order to find the optimal ref-

erence body (reference frame) and closure conditions in the case of loops.

c.) As next the program attempts to find any possible posture of the examined kinematic chain.

(The initial values for the first assembly iteration are obtained randomly.). Note that this pro-

cedure is repeated automatically as long as no posture is found. 

d.) After the initial posture was found the computation algorithm attempts to find further solu-

tions (possible postures) belonging to the current closure mode. Note that after all possible

postures of one mode were found the step “c.)” is automatically repeated until a new posture

(a new closure mode) is found.

- Pause

This command is available only when the computation process is running and it is used to stop

the computation temporarily.

- Resume

This command continues the computation process if it was interrupted by the Pause com-

mand.

- Reset

By choosing this command, the computation process is terminated and the entire data which

has been computed is erased.

Fig 2–29: States of the Computation Menu: a.) before starting the computation, b.) the computation is
running and c.) the computation is temporarily stopped.

a.) b.) c.)
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- Monitor

By selecting Monitor command, the Computation Monitor floating window is opened display-

ing important current data such as the number of assembly attempts and the number of all cur-

rently known curve segments. Moreover, with the help of the Emphasized Curve Pop-Up

menu we can select the curve segment which should be emphasized. If zero is chosen in this

Pop-Up menu all curves are drawn in the normal drawing mode.

Fig 2–30: Computation monitor window.

- Comp. Options...

By selecting Comp. Options... command, the Computation Options dialog box is opened

where the current iteration step and the precision threshold can be specified.

Fig 2–31: Computation Options dialog box.

2.7 Exporting Data

The program Joint supports also an interface which is used to export text files of the computed

data. With various elements of the export interface it is possible to prescribe the form of the

exported text files. This is very useful in the case that the computed data should be further pro-

cessed by some other application which requires certain syntax (animation, spread sheet, etc.). 

When exporting a text file, we have to specify which data should be written to the file. In order

to do this, we have to write the name of the variable which must be separated from the remain-

ing text by special separators. The separators have to be placed immediately before and imme-

diately after the string which will be replaced by the actual value during the text file

generation. For example “...$Rotation.1$...” will be replaced by the actual value of the vari-

able named Rotation.1. The separator is in this case “$”. In this way it is possible to specify

any kind of data which should be saved in the text file. 
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2.7.1 Naming Conventions for the Exported Data

The export interface supports the following name conventions for various variables as well as

point coordinates and direction vectors:

- Rotation variables (R-joint, C-joint, and H-joint): 

The name is specified by “Rotation.n “. The “n” is the object number of the corresponding

joint. For example, “Rotation.3” denotes the variable belonging to the joint with the object

number 3 (shown at the top of the joint symbol in the Project window).

- Translation variables (P-joint, C-joint):

The name is specified by “Translation.n”. (“n” like in the case of rotation.)

- Variables of a global joint (G-joint): 

The names of the components of a rotation vector are specified by “G-variable1.n”, “G-

variable2.n” and “G-variable3.n” respectively. The “n” is the object number of the correspond-

ing joint. 

- Coordinates of a Point Vector: 

For example the names of the point coordinates, belonging to the point named “P9”, are speci-

fied by “P9x.n”, “P9y.n” and “P9z.n” respectively. The “n” is the object number of the corre-

sponding joint. NOTE! The coordinate notation x, y and z has to be lower case (Not “P9X.n”). 

If only the name of a point is given, for example “P9.n”, the point will be interpreted as a vec-

tor and its coordinates in the current reference coordinate system will be written to the text file

as a list of values. The characters which will in the text file define the beginning, the end and

the separators of the vector coordinates can be defined by the user according to the desired

vector notation (See subsection 2.7.2.).

- Coordinates of a Direction vector: 

For example, the names of the vector coordinates, belonging to the vector named “D9”, are

specified by “D9x.n”, “D9y.n” and “D9z.n” respectively. Other conventions are the same as in

the case of a point vector.

2.7.2 The Export Interface

The export interface consists of the Export menu and various dialog boxes where the file for-

mat can be specified. 

The Export menu contains the Export Options..., Data Editor... and the Export... commands.
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Fig 2–32: Export menu.

- Export Options...

By choosing Export Options... the Options dialog box is opened. 

Fig 2–33: Options dialog box.

In this dialog box the following options can be set:

- The Substitution Marker (should be some special character). 

- The Vector Notation. Each vector is in the export text specified by special characters at the

beginning and at the end of a list of its coordinates. The user can specify also the separators

between the coordinates of a vector. For example, the vector  would appear

in the text file as “<2.5, 3, -1.2>”. In this example the characters “<”, “>” were chosen to mark

the beginning and the end of this vector while “,” represents a separator.

- The Transformation Matrix is used to transform the reference coordinate system which was

used for the computation. This does not affect the computation and only the exported point co-

ordinates and direction vectors are transformed.

- Export Editor...

By choosing Export Editor... the Export FileEditor dialog box is opened.

- The Reference Body pop-up menu is used to choose the body in which the global reference

frame for the exported data is fixed. The exported data (i.e. points, direction vectors) are al-

ways transformed relative to this coordinate system.

a = −( . , , . )2 5 3 1 2
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- The scroll-text field is used to define the header of a file-record of the export text file. A file-

record corresponding to one point (one position of a mechanism) is defined as an arbitrary text

including data computed by using this point only. The user can write an arbitrary text and

specify which values of variables and where they will be inserted in the file-record. This is

achieved by using the naming conventions discussed earlier (See subsection 2.7.1.). 

Fig 2–34: Export Editor dialog box.

Moreover, any local export data specified at the bodies (See subsection 2.3.3) will be automat-

ically attached to the end of the text defined in this scroll-text field. When working with a local

Export File Editor belonging to one body, the object number following the point/direction

vector name is not necessary if this vector belongs to the same body. A correct full name is in

this case created automatically when the local text is attached to the main text of the data

record.

- Export Data...

By choosing Export Data... the Data Export dialog box is opened (see Fig. 2–35). It consists

of the following elements:

-Export All Points check-box. If this check-box is checked, for all points the corresponding

file-records will be written to the text file in the same order as they were computed.

-The section where the segments or certain points of the solution paths can be chosen. This

section is used in conjunction with the markers set in the diagrams (See subsection 2.5.1). In

the scroll-list Available Markers one or more desired markers can be selected and transported

to the Selected Markers scroll-list by clicking the button with the arrow (placed between these

two scroll-lists). The points can be removed from the Selected Markers scroll-list by clicking

the Delete button. 
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If the Continuous check-box is checked, a new file-record is added to the text file for each

point of the entire segment between the points which are specified by the first and the last

marker in Selected Markers scroll-list. If the last marker in the Selected Markers scroll-list

equals the first marker in the same list, for each point of the whole input-output curve a new

file-record will be added to the file. If the Continuous check-box is not checked new file-

records are created only for the points specified by the markers in the Selected Markers scroll-

list. 

Fig 2–35: DataExport dialog box.

- Single File check-box. If this check-box is checked, all data records corresponding to the

specified points (selected markers) will be written to one text file. Otherwise for each point a

new file is generated. This check box would be normally checked if a table of desired values

of variables corresponding to different points (selected markers) should be generated. 

- The Export... button. By clicking this button, the Save dialog box is opened where the name

of a new file (files) is specified and a new folder can be created. 

In the case that more than just one marker (point) has been selected and the Single File check-

box is not checked, we will get a file for each point. The name of each file will be composed of

the name specified in the Save dialog box and the current point number, both separated by an

underscore.


